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Introduction

QlikTech was founded in 1993 as a software company in business intelligence (BI). Its PC-
based desktop tool was called QuikView. "Quik" stood for "Quality, Understanding, Interaction,
Knowledge." Initially the software was sold only in Sweden.

QlikView is the most flexible Business Intelligence platform for turning data into knowledge.
More than 24,000 organizations worldwide have enabled their users to easily consolidate,
search, and visually analyze all their data for unprecedented business insight using QlikView’s
simplicity.

QlikView create endless possibilities for making ad hoc queries without requiring tediously
defined structures and hierarchies, as.is typical in other data analysis tools. QlikView promotes
unrestricted analysis of application data, helping users make time-saving and accurate
decisions.

Main features and benefits of QlikView:

» Use of an in-memory data model

> Allows instant, in memory, manipulation of massive datasets

» Does not require high cost hardware

» Automated data integration and a graphical analytical environment attractive for
customers

» Fast and powerful visualization capabilities

» Ease of use - end users require almost no training

» Highly scalable - near instant response time on very huge data volumes

» Fast implementation - customers are live in less than one month, and most in a week

> Flexible - allows unlimited dimensions and measures and can be modified in seconds

» Integrated - all in one solution: dashboards, power analysis and simply reporting on a
single architecture

» Low cost - shorter implementations result in cost saving and fast return on in vestment

Risk free - available as a fully-functional free trial download
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QLIKVIEW DESKTOP

When approaching a decision to implement and deploy QlikView, it's important to first
understand the roles of the various products that comprise a QlikView deployment.
QlikView deployments have three main infrastructure components:

> QlikView Developer,
> QlikView Server (QVS)
> QlikView Publisher.

QlikView Developer is a Windows-based desktop tool that is used by designers and developers
to create.
1) A data extract and transformation model and
2) To create the graphical user interface (presentation layer)

QlikView Server (QVS) handles the communication between clients and the QlikView
applications. It loads QlikView applications into memory and. calculates and presents user
selections in real time.

QlikView Publisher loads data from different data sources (OLEDB/ODBC, XML, XLS), reduces
the QlikView application and distributes to a QVS because differently it's considered a best
practice to separate these two components on different servers.

BackEnd (Including Infrastructure source)

This is where QlikView source documents, created using the QlikView Developer, reside.
These source files contain either a) scripts within QVW files to extract data from the various
data sources (e.g. data warehouses, Excel files, SAP, Salesforce.com) or b) the actual binary
data extracts themselves within QVD files. The main QlikView product component that resides
on the Back End is the QlikView Publisher: the Publisher is responsible for data loads and
distribution. Within the Back End, the Windows file system is-always in charge of authorization
(i.e. QlikView is not responsible for access privileges).

FrontEnd

The Front End is where end users interact with the documents and data that they are
authorized to see via the QlikView Server. It contains the QlikView user documents that have
been created via the QlikView Publisher on the back end. The file types seen on the FrontEnd
are QVW, .meta and .shared documents. All communication between the client and server
occurs here and is handled either via HTTPS (in the case of the AJAX client) or via the QlikView
proprietary QVP protocol (in the case of the plugin or Windows client). Within the Front End, the
QVS is responsible for client security.

Associative In Memory Technology’s

QlikView uses an associative in-memory technology to allow users to analyze and process
data very quickly. Unique entries are only stored once in-memory: everything else are pointers
to the parent data. That's why QlikView is faster and stores more data in memory than
traditional cubes.
Memory and CPU sizing is very important for QlikView, end user experience is directly
connected to the hardware QlikView is running on. The main performance factors are data
model complexity,
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amount of unique data, Ul design and concurrent users.

Building Data Model

A data model documents and organizes data, how it is stored and accessed, and the

relationships among different types of data. The model may be abstract or concrete. A data

model explicitly determines the structure of data.

These are the steps of creating data model using QlikView

Stepl For creating data model firstly install the QlikView then we can open the QlikView from
start-> click on QlikView11.

3 \/,'fl Paint

|_'—H-r§ Microsoft Office Word 2007
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l Motepad

- )

g Vhware Workstation

a
: VLC media player
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Step2: Then the Icon will responding to start QlikView
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Step3: QlikView window will open for accessing the QlikView. Click on New button to create a
new dashboard.

@ QlikView x64 Personal Edition - [Start Page] EI@

i File View Settings Tools Window Help R

0lez s dl @ o o ol el el @) @ 2ol K clear | @ Back D Foniard | ziloc B

T}
QlikView

Geftting Started » i ) License Information -
Recently Opened Documents QlikView Personal Edition
Favorites

Open in Server

Resources

oo

-m Learn QlikView

5] o3

=

Show Start Page When Launching Qlikview

Create a new QlikViev

Step 1 - Select data source

1. Select data source

To create a new QlikView document using this wizard. you first have to select an Bxcel file to use as your data source.
‘When the data has been loaded into your document, the wizard will help you create your first chart.

File Path Browse

Fo.  To select other data sources than Excel files, use the Edit Script dialog. The Edit Script dialog can be found
'0' under the File menu

Show this wizard when creating new documents

< Back Mext > Finish [ cancel | [ _Hep | |

= ==

This window open for loading data from external sources like Excel, etc.. Click on “Cancel”, so
that we can save the document with the blank datamodel and dashboard.

Step4: To save the created document, click on the “Save” icon as shown below.
Save the document anywhere on the local machine.
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@ Save As !! “’? ==
- - |! Deskt » | +. | Search Desktop ”:‘:{L/' |
l\_/”\_/' esktop - 4 SEarch Leskiop '\’r— P
Organize = New folder s v @
E Videos € i
Libraries
System Folder =
& Homegroup - T
Homegroup
/M Computer Q System Folder
&, Window 2007 (C
ca Office (D:) |l DataStage By VK
. Software (E9) 3, System Folder
= Provide the File name as
€l Network i Computer = H
a V| System Folder "QIIkVIew Demo”
/M BISP-6
- &% Metwork -
File name: <« hd
Save as type: lQIik‘u’iew Files (*.qvw) vJ
| Hide Folders Save ] I Cancel J

*

Step 5 For loading the tables into the QlikView datamodel, we need to open the Script editor
(“Edit Script”) as shown below.

= QlikView x64 Personal Edition - [Ch\UsershashDesktoph 1 2. gqwvw]

il File Edit Wiew Selections Layout Settings Bookmarks Reports Tools Object Window
| ] New CtieN It | ] ¥ | @] @ 52 23 K Clear - | @ Baci
[ = Open... Ctrl+ O
®=% Openin Server... Ctrl+ Shift+ O
Open URL...
Open FTP...
Close
Favorites »
= Save Ctrl+5
Save As... F12
Mail as Attachment...
Print Sheet...
Source Control »
Export »
Import »
E[&F Edit script.. CticE |

J =} | Reload

A

Ctrl+R }- Metwork
|

-

lfiEmiE == hassaaaiSi—

Once opened, the Script Editor window will appear with some default set statements. These
Set statements will tell QlikView what should be the default number settings to be followed
throughout its use in the document.
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‘@ Edit Script [C:\Users\as\Desktop\QlikView Demo.quw]
£ File Edit Inset Tab Tools Help

) Reload (3 Debug | [ & | 4 = (% | D 3 <1 3 Tabs Main =|=8 =
Main
SET ThousandSep=',"'; |

SET DecimalSep='.";

SET MoneyThousandSep=","

SET MoneyDecimalSep="'."';

SET MoneyFormat='S5#,##0.00; (S#,##0.00) ' ;

SET TimeFormat='h:mm:ss TT"';

SET DateFormat='DD-MM-YY';

SET TimestampFormat="'DD-MM—-YY h:mm:ss[.f££f] TT';

SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;Aug; Sep;Oct;Nov;Dec';
SET DayNames='Mon;Tue;Wed;Thu;Fri;Sat;Sun';

Data | Functions | Variables | Settings |

Database Dats from Files

OLE DB - [] Relative Paths Table Files...
Hlnserre
Force 32 Bit Qlikiiew File,
“wieb Files.
Field Data..

Step 6 Now the data records as'in the form of access or excel sheet this covers the procedure
extract which is the fundamental procedure of datawarehousing by connect option we import
the access file in which records are saved.

Select the Database connection type from Data tab in the Edit Script window as shown below :

Dala | Furcien | Vaiatis | Setings

Dt Doty i F e
OLE b8 v | Connedl Fielatren Pt Tisble Fias
Use FTP
Hfuce D6 Select G Fie
Wt Fiss
Fiski Dl

Ok Canecal Heg

[F | Data Link Properties S! ?,?. (===
o=

Provider | Connection | Advanced | Al

Select the data you want to connect to:

OLE DB Provideris) ‘™
Microsoft Jet 4 0 OLE DB Provider

Microsoft Office 12.0 Access Database Engine OLE DB Pro
Microsoft OLE DB Provider for Analysis Services 3.0

Microsoft OLE DB Provider For Data Mining Services
Microsoft OLE DB Provider for Indexing Service =
Microsoft OLE DB Provider for OLAP Services 8.0

Microsoft OLE DB Provider for Oracle

Microsoft OLE DB Provider for Search

Microsoft OLE DB Provider for SQL Server

Microsoft OLE DB Simple Provider

MSDataShape
OLE DB Provider for Microsoft Directory Services -
<[ i 3

[ ok || Cancel |[ Hele |

Now the popup window appear “Data Link Properties”, Then we will need to select the data
base “OLE DB..” then the type of OLE DB we want to use then click on “Next”.
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Select the data provider under Provider tab, then “Next”.

" Data Link Properties 5’ ‘,? IEI

X

Provider |Cor1nectior1 I Advanced I All |

Select the data you want to connect to:

OLE DB Provider(s)

Microsoft Jet 4.0 OLE DB Provider

Microsoft Office 12.0 Access Database Engine OLE DB Pro
Microsoft OLE DB Provider for Anahysis Services 9.0
Microsoft OLE DB Provider For Data Mining Services
Microsoft OLE DB Provider for Indexing Service
Microsoft OLE DB Provider for ODBC Drivers
Microsoft OLE DB Provider for OLAP Services 8.0
Micresoft OLE DB Provider for Oracle

Microsoft OLE DB Provider for Search

Microsoft OLE DB Provider for SQL Server

Microsoft OLE DB Simple Provider

| »

m

MSDataShape
OLE DB Provider for Microsoft Directony Services -
4 TIE | 3
[ ok || Cancel |[ Heb |

Browse the file or MS Access datadase which we want to import into QlikView.

7 Data Link Properties 5] ?R ]’ ==

Provider | Connection | Advanced [ Al |

Specify the following to connect to Access data:

1. Select or enter a database name

[

2. Enter information to log on to the database

User name: Admin

Blank password || Allow saving password

Test Connection

[ ok ][ cancel ][ Hep |

We will select the file “Salesmanl.mdb” which is already available in local machine.
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@ Select Access Database !j j‘;! ===

r W A
- ) [P Desktop » ~ [ 42 || Search Desktop @ |
Organize ~ Mew folder Bz ~ [ @

- It FiE ToTerET =

I Favorites
B Desktop k I Mew folder (2)

%l Recent Places File folder

% Downloads

=" Google Drive quilk

File folder

mn
ay

il Libraries i sl modelar
%] Documents £ File folder
& Music
=] Pictures Teradata _13-Sep-2013_files
B videos File folder |
salesmanl
% Homegroup Ile Microsoft Office Access Database
- 340 KB -
File name: | ~ | [Microsoft Access Databases (" ~ |

[ Open | [ cance |

Enter the username/pwd to connect to the database and then click on the test connection. A
popup window appear with message connection is succeeded.

EF | Data Link Properties I"=="]

Connection | Advanced | Al

Specify the following to connect to Access data:
1. Select or enter a database name:

CUsershashDesktoptsalesman 1.mdb E]

2. Enter information to log on to the database:

User name: Admin

Microsoft Data Link

IOI Test connection succeeded,

Test Connection

[ oK | [ caneal | | Help ]

Now that we have successfully connected to the Access database, we can see the connection
details in the Script Editor window.
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(@ Edit Seript [C:\Users\as\Desktop\QlikView Demo.qvw] = | ]
i File Edt Inset Tab Tools Help

"} Reload [ Debug | [ | 4 5 ] 4D [ &1 5 Tabs Main o8

tain

SET ThousandSep="','; il
SET DecimalSep="'."';
SET MoneyThousandSep="',"';

SET MoneyDecimalSep='.';

SET MoneyFormat='S#,##0.00; ($#,##0.00) ',

SET TimeFormat='h:mm:ss TT';

SET DateFormat='DD-MM-YY';

SET TimestampFormat='DD-MM-YY h:mm:ss[.£££f] TT';

SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;Aug;Sep;0ct;Nov;Dec';
SET DayNames='Mon;Tue;Wed;Thu;Fri;Sat;sun';

OLEDB CONNECT32 TO [Provider=Microsoft.Jet.OLEDB.4.0;User ID=Admin;Data Source=C:\Users\as\L

<[ n ] b

Data | Furctions | Warisbles | Settings

Database Diata from Files

OLEDE - [7] Relative Paths Table Files.
Buere
Force 32 Bit Dlikview File
Web Files
Field Data

O @€ (] =]

[e]

QLEDE CONMECTIZ2 T0 [Frovider=Microsoft.

Step 7: Next we have to Load the fields of the MS Access table in the Datamodel. Click on
“Select” button as shown below :
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@ Edit Script [C\Users\as\Desktop\QlikView Demo.qviv] ===
i File Edit Inset Tab Tools Help

) Reload [ Debug | (o S| % = (2] O [ 51 (2 Tabs Main P ==

Main

SET ThousandSep="',"';

SET DecimalSep='."':

SET MoneyThousandSep="',";

SET MoneyDecimalSep="'."';

SET MoneyFormat='$#,##0.00; (5#,##0.00) ',

SET TimeFormat='h:mm:ss TT';
SET DateFormat='DD-MM-YY';
SET TimestampFormat='DD-MM-YY h:mm:ss[.f£f£f] TT';

SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;Rug;Sep;0ct;Nov;Dec';
SET DayNames='Mon;Tue;Wed;Thu;Fri;Sat;Sun';

OLEDB CONNECT32 TO [Provider=Microsoft.Jet.OLEDR.4.0;User ID=Admin;Data Source=2\Users\as\C

7 I

Data | Functions | Yariables | Settings

Database Data from
OLE DB - elative Paths Table Files..
[CluseFIP Qs File.

7] Force 32 Bit
ok [ Caneel |[ Hep |
- ] s jwz || ook o . w032am | |
e EslElEs] TN

Create Select Statement window will appear, displaying all the tables (with fields), views,
synonyms & aliases available'in the database.

]
¢

==

@ Create Select Staterent

BeeSmes Provider=Microsoft Jet OLEDB 4.0;User ID=Admin;Data Source=C:\U
Database

Ovarer Support...
Database Tables Figlds Teut Order -
Tables — - ]
Wiews Distributar 1 .
] synorgms o Here the fields
[ System Tables Salosman |0 a r‘e S h OW n
Dl 7] Show Icon for Key Fields «— | available in
Seript |Table | Columnsl Previewl Blobsg |
SQL SELECT ¥ - 0 Calumn
FROM sales; ) Row
() Structured
[ Preceding Load
A Add
d b
[ 0K ] [ Cancel ] [ Help ]

By default, the “*” is selected and the default SQL script is displayed in the Script tab, as
shown above.

We can always have the privilege to select individual fields as required. And the SQL script is
automatically generated by QlikView in the Script tab.
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@ Create Select Statement EI =] \EI

Data Source Provider=Microsoft.Jet OLEDB.4.0;User ID=Admin;Data Source=C:\U

Owuner Support

Database Tables Fields Text Order -
Tables -
Wisws Distributor [d
[ Synoryms 1D
[ Spstem Tables
[ liazes

[] Show lcon for Key Fields

Seript |Table I Cnlumnsl Previewl Elobs |

SQT. SELECT ‘Distributor Td", + @ Column
ID, ) Row
Salesman, () Structured

*Salesman ID"

[ Preceding Load
FROM sales;

Add

q 3

[ QK ][ Cancel H Help ]

Click on OK, to proceed further.

Now, in the below “Edit Script” window we can see that we have 2 things :
1) Connection link to the datasource

2) Selected Fields to be loaded into QlikView datamodel.
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@ Edit Script [C:\Users\as\Desktop\QlikView Demo.quw] || P S|
i File Edit Insert Tab Tools Help

=} Reload (% Debug | [ | 4 =3 %] O [ &1 50 Tabs Main ===

Main

SET ThousandSep="',"; i
SET DecimalSep='."';

SET MoneyThousandSep="',";

SET MoneyDecimalSep="'."':

SET MoneyFormat='S$#,##0.00; ($%,##0.00)';

SET TimeFormat='h:mm:ss TT';

SET DateFormat='DD-MM-YY';

SET TimestampFormat='DD-MM-YY h:mm:ss[.£££f] TT';

SET MonthNames='Jan;Feb;Mar;Apr;May;Jun; Jul;Aug;Sep;Qct;Nov;Dec';

SET DayNames='Mon;Tue;Wed;Thu;Fri;sat;Sun';

OLEDE CONNECT32 TO [Provider=Microsoft.Jet.OLEDB.4.0;User ID=Admin;Data Source=C:\Users\as\L
SQL SELECT ‘Distributor Id‘,

ID,

Salesman,

“Salesman ID
FROM sales;

< i v

Dats | Functions | Variables | Settings

Database Data from Files

OLE DB - [ Relative Paths Table Files..
Fluere
Force 32 Bit Qlikyigw File...

ok || Canedd |[ Help |
elElEle] ST

Step 8:

Now its time to load this data into QlikView. Click on “Reload” button as shown below :

@ Edit Script [C\Users\as\Desktop\QlikView Demo.qvw] ==
File Edit Inset Tab Tools Help
5} Reload |3 Debug | = | 4 -3 %] O [ &1 & Tabs Main -8 >

Once loaded, we can see all the fields are now available in QlikView datamodel.

Select all fields and Add all fields
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!

Page 16



http://www.bisptrainigs.com/
http://www.bispsolutions.com/

Sheet Properties [Main]
| General | Fields |Objeds | Security I Triggersl
Available Fields Fields Displayed in Listhowes
Distributar 1d
Add > ID
Salesman
Add Al = Salesman 1D
< Remove
Show Fields from Table
@ Al Tables -
[7] Show System Fields
OK || Cancel || Mppy |[ Hebp

Click on “OK".

Now we can see that all the fields are now available as list boxes in QlikView dashboard.

Page 17
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@ QlikView 164 Personal Edition - [C:\Users\as\Desktop\QlikView Demo.qvw"]
i File

L]l ]

Edit View Sclections Loyout Seitings Bookmarks Reporis Tools Object Window Help
HIRN=RN™ N IRESEE, MRl AR R ANc:A| t_a)@?lixg [ Clear - | @ Back @) Forward | &) Lock g‘umock!

Main
Distributor Id »
1
Salesman ID A 2
101 3
102 4
103 s
104 6
105
106
L - Galesman A

4 abhi

s ajay

5 akash

’ amit

8 ankit

9 anuj

For Help, press F1 17-09-1310:38:41 AM*  D:6/6 F:6/6
= = = -
) ] TN | Wi 81 5 | WG g gy 1BOAM
@.e = ale]bi] e rom e

17-5ep13 |

These are the field

Step 9:
Joining more tables of different format.

Open Script Editor (Ctrl + E), Click on “Table Files” under Data tab.
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@ Edit Script [C:\Users\as\Desktop\QlikView Demo.qvw*] o e
i File Edit Inset Tab Tools Help
) Reload [#Debug | [ | % a3 7| O (140 (&9 Tabs Main - |28 >

Main

SET ThousandSep="',"'; I
SET DecimalSep='."';

SET MoneyThousandSep="',"';
SET MoneyDecimalSep="'.";

SET MoneyFormat="'S$#,##0.00; (53, ##0.00)';

SET TimeFormat='h:mm:ss TT';

SET DateFormat='DD-MM-YY';

SET TimestampFormat='DD-MM-YY h:mm:ss[.fff] TT';

SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;Aug;Sep;Cct;Novs;Dec';
SET DayNames='Mon;Tue;Wed;Thu;Fri;Sat;Sun';

OLEDB CONNECT32 TO [Provider=Microsoft.Jet.OLEDB.4.0;User ID=Admin;Data Source=C:\Users\as\C
SQL SELECT ‘Distributor Id®,

ID,

Salesman,

“Salesman ID"
FROM sales;

[l 1 | [

Data | Functions | Variables | Settings

Database Data from Files

OLE DB - ] Relative Paths <
Husere
Force 32 Bit Qlikiew File..
Wb Files
Field Data.

[ ok J[ cancel ][ hHen |

ele =le ] Gle]d]e |

Select the “Transaction Tablel.xIs” > Open

@ Open Local Files (==
Lok in: [ Desktop - &3 m-
I 263KB i
a1
ehe T GHR_Model
Recent Places Text Document
857 bytes
! T kkkk
Desktop | Iead Document
62 bytes
-_'_‘_' T medified ghr script
:.:l.J Text Document
Libraries 364 KB

A

. : Teradata _13-5ep-2013
- Firefox HTML Document
Computer 119 KB ‘ ‘
Transaction Tablel E
& @ Microsoft Office Excel 97-20... R
ol | 175k 5
Metwork
File name: Transaction Table1 -

Flesoftype: [ All Table Files «] | Cancel |

“File Wizard : Type” pop-up window will open. The File has been automatically identified by
QlikView as “.xIs” and all the available fields in the sheet are previewed / displayed.
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2 File Wizard : Type @
File Type Tables Header Size
_) Delimited Sheet1s - MNone - 0
" Fixed Record Labels
_) Dif Embedded Labels -
@) Excel (xls)
_) Excel (usx) customer ID = I]]ajr x krﬂgs margin *x II.is‘t i
_) Html 1 Monday 2% 50
) Qwd 2 Tuesday 3% 40
wml 2l 30
) Qv 4 70
5 80
& 85
4 »
I < Back I I MNext = J I Finish I [ Cancel ] I Help

Click on “Finish”.

Now, we can see the load statement is created with all the fields from the excel file in the script
editor window.

= EOIT JCTPT [ WUSErS\as\UESKIOP IV IEW LEMO.qvw™ |

i File Edit Inset Tab Tools Help
L Reload @ Debug | | | A 0

(=[]l = ]|

|
| Tabs Main x5 =

hdain

FRCM

LOAD

FRCM

Salesman ID
sales;

[customer ID],
Day,

[Gross margin],
[List price],
month,
[product Id],
sales,
[Salesman ID],
[Serial no.],
[Tran Id],
year

[C:\Usershas\Desktop\Transaction Tablel.xls]
(biff, embedded labels, tabkle is [Sheetl$]):

m

Step 10:

In this step we will see the Generation of keys and relation between them and will join these 2
tables loaded from 2 different sources.

Database “salesmanl” and table “transactiontablel” contains one field in common.

www.bispsolutions.com
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1) If one of the field in both tables are same then QlikView automatically generates the relation
between both tables and will merge the keys.

Sheet Properties [Main] @ Here the
| General | Fields |Objec:ts I Security I Triggers| salesman
Available Fields Fields Displayed in Listbaxes id field as
¢ customer (D Distributar 1d We” as
oa Add > 0 values are
(Gross margin Salesman
List price Add Al = 47 Salesman D same so
<—
Chssin son
product Id < Remove .
sales relation
seral o automatic
ran Id
year aIIy
~NAnAratAA

Show Fields from Table
@ All Tables -

[] Show System Fields

[ ok || cancel || oy Help

From here you can select those keys which you wants to display in listbox by double clicking
the key.

Select more fields to the right, to be displayed in dashboard.
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Sheet Properties [Main]

| General | Fields |Dbject5 | Securty | Tﬁggers|

Awailable Fields Fields Displayed in Listbowes
customer |0 Day
(Gross mangin Add > Distributor Id
List price ID
marith _A::Id Al sales
product 1d - Salesman
Remove | | & SaksmanD
Tran Id year

Show Fields from Table
@ Al Tables -

[7] Show System Fields

| ok || cancel || pply || Hep

www.bispsolutions.com www.bisptrainigs.com www.hyperionguru.com Page 22



http://www.bisptrainigs.com/
http://www.bispsolutions.com/

& QlikView x54 Personal Edition - [C\Users\as\Desktop\QlikView Demo.quvw™] || S

i File Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help -8 X
054 ) GLE ]9 DT ) | 2] k2 53 K Clear - | @8ack @ Forvard | @ Lock af Uniock [
Main
- Distributor Id ]
— / |
2
3
4
5 Salesman ID e
. 101
102
103
104
D ¢ Salesman s 105
4 abhi 106
e ajay
6 akash
7 amit
8 ankit
9 anuj
year »
2001
Day o 2002
Monday 2333
Tuesday
sales l 2005
3000 2008
5000
10000
15000
35000
40000
For Help, press FL 17-09-13 10:52:28 AM*  [:6/6 F6/6
— =gl 4= o 2 )
RN ER A Y - B

In the above table, we can see only one “Distributor ID” column, as it the key between the 2
tables.

Now we look at the Table Viewer in QlikView to see how the 2 tables are joined and
represented.

To navigate to Table Viewer, Click on below shown icon or Ctrl + T

ek Veren el Pt Fodisos - 11" e BV ok o Dot e | T =l
B i R e I I -®2
dad o 4 A 0 o 3 i T e e |

The two tables automatically containind Table o the same key field which is “Salesman

ID"
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@ CA\Users\as\Desktop\QlikView Demo.qvw | | =

‘g Export Image “f: Export Structure (= Print =3 Copy Image | 23 Auto-Layout | 100% - | Internal Table View -
SHEETI)
Salesma... s fe——
custame. .,
Day
Gross ...
Listprice |z _
month Sales:
product Id ————as| Salesman ID
sales Distributor Id
Serial no. D
Tran Id - Salesman

0k ]| Cancel || Help |

E

Ol= e (¢~ [ L]

L= ” f IH e H e )

I

2) We now have another scenario, in which the field format / name is little bit different but
contains the value same between tables.In this case join will not be automatically created as
the field names are not matching. But we have to establish join between those fields.

To sort this out, we willlnow import one more database / table

(customer table.xlxs) into QlikView datamodel to see how we can fix this.

Below are the fields of the table “customer table.xIxs”
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@ Edit Script [ChUsers\as\Desktop\QlikView Demo.qvw™] o || =P | &8
! File Edit Inset Tab Tools Help

) Reload [BDebug | A S| 4 5 ] ‘}_) ] <51 |2 Tabs Main v |28 =

Main
*Salesman ID" G
FROM sales;
2 File Wizard : Type @
LOAD [customer| File Type Tables Header Size
]?zir; o5 mal () Delimited Sheet1 - MNone - |0
[List pri () Fixed Record Labels
month, © i Embedded Lzbels -
roduct _
[p () Excel (xs) F
sales, = 2 TR = T == T i
[Salesman| @ Excel (xisx) Customer ID Stomer EEl Ty zip t|_\
[serial 1 © Html 1 amit abe def ind —
[Tran Id] 5 qud z anuj pagr stw ind
() Qw
year 3 ankit bus stand |bpl ind L
FROT \as\ ‘ ezl 1 akash railway |bpl ind
[e : Usersiasih O Qv 5 =bhi ronawala |mumbai ind
(biff, embedde
& ajay mahu indore ind
4| 1 | il b
4 |:| 3
Data Setiing
Database [ < Back ] [ Mext = ] [ Finish ] [ Cancel ] [ Help
OLE DB -
[TTUse FTP ) »
Force 22 Bit Qlikiew File...
wieb Files...
Field Data...

o || @

&) = e

We will now directly import this into the datamodel.
Click Finish.

Click Reload.

Now looking at the Sheet Properties window which pops-up automatically after the reload is
done.

Here the two fields are shown
First one is “customer ID” from transactiontablel.xls

Another one is “Customer ID” from customertable.xlxs.
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“u,n

The difference is the “c” in both the fields / columns. “c
another exists in lowercase. This mean key is not allowed / possible.

QlikView Rule :

be similar, as QlikView is case-sensitive.

.Mﬁ'upﬂiu [Wain]
{(byects | Securty | Trpgers

Cumnarn | Fidcls
Aorplabin Faldy
ddress
ity
[=T- ¢ 5y
= ]
P> customear iD
¥
T
Lisi pwice:
ooyt i

Dol i
Trmn b2

Shder bebSiem |abia
@ Al Tebiss

e Tywtem Fakds

in one table exsist in uppercase or in

To have join between a common field in 2 tables, the column names should

o]
Fiskds: Dhapdarpsd i Lithooss
Dy
i Degtricadior i
Add Al xe Laied
Subaaran
« Flarnave # Dobegrran 1D
'ha d
| oK Carvoel Heip

Now when we see in the Table Viewer, there isn’t any join created between the 2 tables, just
because of the “c” is in different case in both the column names.
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@ ChUsershas\Desktop'QlikView Demo.gvw
d‘LgExportImage “EExport Structure (= Print =3 Copy Image | “23Auto-Layout | 100% = | Internal Table View

Lo e

Customer 1D
customer
address

city

zip
cuoritry

Sheptdls
BTRREN
custorme. ..
Day
Gross m...
List price

miont

product Id

sales

Serialno,
Tran Id -

m

—a| Salestman ID
Distributor Id
D
Salesman

I‘
L1}

ETe @ =]

HIEFIEY

so the solution is that we have to do editing in scripting section where all the three database's

script are already loaded.

With the "as" keyword we will establish the relation. and show that both fields are same and
will rename the column name in “Customer table.xIxs” load statement in Script Editor.

Load [customer ID] as [Customer ID]
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@ Edit Script [C\Users\as\Desktop\Qvdemo2.qvw~] 1 [
! File Edit Inset Tab Tools Help

) Reload ¢ Debug | (el | 4 3 (B[ O 71 &1 2 Tabs Main =

Main

[Salesman ID], -
[Serial no.],
[Tran Id],
year
FROM
[C:\Usersias\Desktop\Transaction Tablel.xls]
(biff, embedded labels, table is [Sheetl$])s

LOAD [Customer ID]as [customer ID]|,
customer,
address,
city, B
zip,
cuontry
FROM
[C:\Users‘as\Desktopicustomer table.xlsx]
(coxml, embedded labels, table is Sheetl):

m

4 L

Data | Functions I Warables I Settings|

Databaze [rata from Files

OLE DB - [] Relative Paths Table Files...
=P
Force 32 Bit Qlikiew File...
wieb Files...
Field Data...

5 SAONEAE )

[ 0K ][ Cancel ][ Help ]

._:‘;)c_‘/:l )@ ‘ T

Now we can see the two keys start containing the relation ship between three tables.

. e [ o - A= L ! . P
Theet Properties [Main] ===
Germrnl | Pl | Obgeets | Securty | Trgges |
Forsllabie Fasids Fosicly Dinpdayyed in (Listhomes o
adcets Eustom i
oy f Add £ oo 1D
=T 5 3 y Chstrbtor id
Dy S Al 5 I
Caitrad MBS % | e
Lat price < Femove Seeaman
manth : & Salegran I
prsdhuct L
Serial i
Tran Id
e
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@ Ci\Users\as\Desktop\chartZ.qvw =N RS
g Export Image & Export Structure =4 Print =3 Copy Image | Z5Auto-Layout | 100% - | Internal Table View -

Sheet]

—a| customer ID
custamer
address
city
SHEEHTS] P
custome.,,  a fe— CLanry
Salesma... [ [fo—
Day
Gross m...
Listprice |=
rmonth 5dles;
product Id —a| Salesman 1D
sales Digtributor Id
Serial o, ]
Tran Id - Salesman
-

HREEFI

Step 11 :

Now we will see how to add new list boxes / fields in the QlikView

dashboard as and when required.

Rightclick ->new sheet obje€t==list box
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@ QlikView x64 Personal Edition - [C:\Users\as\Desktoph\Qvdemo2. quvw®]

! File Edit View Selections

FRN=RoN® = AR E N M

Layout Settings

Bookmarks Reperts  Tools

Object Window Help

=)=

-8 X

| & | | 2 | [ | @) [5? ! :ad K Clear - | (@ Back (&) Forward | (5 Lock E

[ ot Av-..

Salesman ID
101
10z
103
104

This will open the popup window, from where we can select the desired

ﬁ Properties...
g3]| Select Fields...
[ New Sheet Object v |[lE] List Box... |
Copy Sheet Z| Statistics Box..
ac;l;istumel‘ 4 Paste Sheet Object E:I Multi Box...
ajay Paste Sheet Object as Link M| Table Box...
akE_I_Sh Print... "i] Chart..

field from the “Field” drop down.

Mew List Box

General | Expressions | Sort | Presentation | Mumber | Fort | Layout | Captinnl

Object 1D

Always One Selected Value
[ Overide Locked Field
[7] Show as TreeView

Print

[T Prirt All Values

Layout Dependent Print

-

Title
| &
Field Search
address - Include Excluded Values in Search
'\ <uge default>
Use as Title
Default Seanch Mode
fnd mode [C] Show Frequency <use default>
[T Show Atematives In Percent
[ Hide Excluded | More Search Settings |
[T Read Cnly

0K

We will now select the “product 1d” field.

I

Cancel || Hep

D
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Newlorter =
General | Expressions | Sot | Presentation | Number | Fort [ Layout | Caption |

Title: Object 1D
=use field name= E]

Field Search

city
cuontry
customer

& customer D
Day
Distributar Id
Gross margin
)
List price
morth
product Id
sales
Salesman

47 Salesman ID
Serial no.
Tran Id

O O e O

O O

year
zip

<Expression>

| product Id i Include Excluded Values in Search

3

ings |

it Print

5 A__/—-
a';‘;ftumer Distrib... product Id
1 s1z D ezl
ajey
2 53
akash 4
3 540
amit 5
) 4 545
ankit f
e s 560 7
& 570 M
g
year » Salesman
2001 2002 2003 2004 2005 2006 address P - abhi
abe 3000 ajay
bus stand 5000 akash
mahu 10000 annit
par 15000 ankit
railway

ronawala

35000
40000

anuj

customer ID

N ]

For Help, press F1 17-09-1311:58:00 AM*  D:6/6 F:6/6

Creating a Chart :
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Creating chart using table in which the graph can be implemented
between two values / fields, one can be taken in the X-axis and another

one on the Y-axis.

Before creating the chart, we will do some formatting and clean up of the
fields/ list boxes available on the dashboard.
We can change the view of field / list box from horizontal to vertical by

Ignoring or de-selecting the option “single column™.

List Box Properties [Distributor Id] =

| General | Expressions | Sort | Presentation | Numberl Fort | Layout | Cap‘tion|

Image Options Alignment
Reprezentation Left Certer Right
Text - Text L
Numbers @
Image Formatting - - )
Fill with Aspect Multiine Settings
Hide Test When Image Missing [ Wrap Cell Text
Selection Style Ovemide Height |2 ~| Lines
<User Default> - r

3 [ Single Calumn

] Suppress Horizontal Scroll Bar
% | Fixed Number of Columns 2
] Crder by Column

[ Cell Borders

Highlight Search Substring

Background...

oK [ Cancel | [ Apply || Heb

Now we can see how the values in the “Sales” list box are transposed from

Vertical to Horizontal view.
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‘= QlikView x64 Personal Edition - [C:\Users\as\Desktoph\Qvdemo2.qvw™] =Nl R =<
! File Edit View Selections Layout Settings Bookmarks Reports Tools  Object  Window Help -5 X
NG5 ) 239 o) 21 ) ) 202 Wiad K dear - | @8ack @ Forvard | @ Lock o niock
Main
Salesman ID » _—
101 Distrib... ~
102 1 D ~
103 2 4
104 3 g
105 4 &
106 s 7
& g
9
year p customer £
2001 2002 2003 2004 2005 2006 salesman el P o abhi
abhi 3000 5000 10000 15000 35000 40000 ajay
aiay akash
skash ik
it ankit
ankit

arij

customer ID

Gk = B

For Help, press F1

anuj

17-09-13 11:58:00 AM*  D:6/6 F: 6/6

2 €@ (& all=]d] e]

For creating the chart :

rightclick on screen->New Sheet Object->Chart
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@ QlikView x4 Personal Edition - [C:\Users\as\Desktop\Qvdemo2.qvw™]

i File FEdit View Selections Layout Settings

Bookmarks Reports  Tools

Object Window Help

_1 =7 ==X E _}l “) |\}_)| Zlfﬂgl @ | [ ] t_l)»@')nxjj K Clear - | (& Back () Forward | (£ Lock _J‘Unlock!

Lo e |l

-FX

Main

Salesman ID A —
101 Distrib...
102 1 1D ~
103 2 4
104 3 3
105 4 &
106 5 7
& g
9
year # customer
2001 2002 2003 2004 2005 2006 Salesman el calpe P bhi
abhi ﬁ Properties... 15000 %S00 @0nin ajay
o 3] Select Fields... Bj ListBo..
amit ‘ Mew Sheet Object ) | = Statistics Box...
ankiF Copy Shest E| Multi Box...
anuj E
15| Paste Sheet Object o | VRSl
Paste Sheet Object as Link | 'Il_ diit
=| InputBox.
Print... i i
A oo e V| Current Selections Box...
=3 Copylmage to Clipboar E
S C Q|| Button...
Export Image to File E
Al Text Object...
@ff Felp S| Line/Arrow Object...
[ &) Slider/Calendar Object...
F =
5 |l Bookmark Object...
& |a] Search Object.
| Container...
@] Customn Object...
System Tabl
Create a new chart ystem 1anle
ARG R EIE
[y L] =
- |

Select the type of chart you want to use

Requirement : “Average Sales Vs. Year “ in bar chart format

11:58:00 AM*

D:6/6 F:6/6
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- 1 & 1| —™ | HEN | #s | 1y "W

General @
Window Title Object ID
Show Title in Chart
o
[] Read Onty
Calculation Condition
select (]
Chart Type Fast Type Change
chart Alowed Types
, [ S — "'h-_ (_" .-I = [ BarChart -
-_/[I . P @ U 5| | Line Char
/ . [ Comba Chart =
 —— [ Scatter Chart e
X ol tfee Y ; [~ Pie Chart
O Hao ' | [ Pivat Table
et e —— [ Straight Table -
Prefemed lcon Position
[ Reset User Sizing ] Reference Mode: 1 In Chart
[ Reset User Docking ] [ Eror Messages... Dimmed - @/ In Caption
Back Mext = Finish Cancel l [ Help

Choose the fields (Year) with which we have to plot a chart include them by

“Add” option
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- I & 1 —™ | HEN | #= | | " Tl

Dimensions @
Available Fields/Groups Uzed Dimensions
address Add >
city
cuontry < Remove
customer
# customer 1D Promate
Day
Distributor Id Demote
%"55 e | Add Calculated Dimension... | | Edt...
List price Settings for Selected Dimension
month [7] Enable Conditional
product Id
sales
. Salesman [ Suppress When Value Is Null
& Salesman D
Serial no. [7] Show All Values
Tran Id [¥] Show Legend
@] Label
[ Show System Fields E]
Show Fields from Table B Advanced...
All Tables - E]
Mo Breaks
| Animate... | [ Trelis.. |
| <Back || Net> | | Fnish || Cancel | [ Hep

By clicking next the popup window will appear in which you can prefer

which type of Expression you want to perform with data.
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@ Edit Expression =n | F=h =

! File Edit Sef =ddess
city
cuonkny
customer -

& customer 1D
Day
Diztribtor 1d
Gross margin
I
List price
month
product |d

Fields | Function ., Salesman
& Salezman 1D

. Senial no.
Aggregation Tran Id 0 x

Expreszion O

year
Table ip [T] Shawe Spstem Fields

Field address E] Digtinct

Ok [ Cancel H Help

We can create an expression from a varied choices of available functions.

1| @ Edit Expression =N

! File Edit Settings Help
Expression OK

F b

Fields | Functions Variablesllmages|

Agagregation t] 0 Fe

Table [ Show System Figlds

First String
Fractile

Field

Digtinct

Ok [ Canhcel H Help

Mizsing count k
Mode \alue
Ml count
Mumeric count MNext > ] [ Finish ] [ \Qancel ] [ Help ]
Only value \

Skewness
Std dew
Sum

Text count _
Total count . . 17-09-13 11:58:00 AM D:6

By clicking “Paste” button the expression will be copied in the blank area.

The expression we have selected is the “Avg (sales)”
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Expreszion OF.

1lAvg (sales)

4

Fields mnctions | Wariables | Images|

- D
Table @ Al Tables - Show Syster Fields
Field sales - Distinct

Agaregation Average

i

Click “OK”

D

[ ok

H Cancel l_ﬁ;ﬁ_
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Expressions @

ali B Enable [T Conditional
Label
Definition E]
Avg (sales) E|
Comment
[

Delete Demate Lngroup Hm=s

Accumulation Display Options Total Mode

i@ No Accumulation Bar Mo Totals

Full Accumulation Symbal Auto (@ Expression Total

0 Accumulate 10 = Steps Back = Maomal Sum

Trendlines Stock of Rows

Eﬁifrge B 2:2: ;?uamn B E:; 25; Bars Bar Border Widh

g ﬁl:u!‘mnmia! Df %-"j d: [[] Values on Data Points Opt -
[ Text on Ao Expressions as Legend

[7] Text as Pop-up

| <Back || MNed> || Fmsh || Cancel | [ Hebp
A

Click on “Finish”.

The chart is created which shows the six year Average sales report.
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Avg (sales)
40,000
30,000
20,000
10,000 .
- . G
2001 2002 2003 2004 2005 2006
year
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